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P
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KT E BN E & 2 548 GWIN(R)AT GW2A(R) £ 41 FPGA 77 i 4t 12
Wi B 77 T I8 FH AR PE K DhRE, SRS RAIE) FPGA 77 i 4 A2 I B T T & f
H, BEEF B E 48 Gowin FPGA 7. & = 54k FPGA 7 i
LIRS R AREIAE AR I B R

1.2 B~

AP R R 5 SIS T A s 3R FPGA 77 .

1.3 tH3X3CHH

I B = =2 ARG http://www.gowinsemi.com.cn 7] L 4. &
F UL AH ISR :
o GWIN(R) %% FPGA 7= it 4 AL AC & Tt
o GW2A(R) %% FPGA 7= il dw e fic & T/t
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1.4 RiE. 4ingiE

1.4 Rig. HERKiE

R 1-1 I AT BLRA CORE . A AT OB X .
& 1-1 RiE. FEWIF

RiE 4i0ETE 2R X

LUT Look-up Table "R

FPGA Field Programmable Gate Array B3] e TR 5
JTAG Joint Test Action Group BeEMAAT ) A
GPIO General Purpose Input Output AN RO
SPI Serial Peripheral Interface AT MR
SRAM Static Random Access Memory FRAS BENLAT A 2%
MSPI Master Serial Peripheral Interface F AT
IEEE E]rfsitﬁgzrc;f Electrical and Electronics B/ AT T T AT 2
ID Identification SRR

CRC Cyclic Redundancy Check TEIR TR

1.5 FRZ SRR

o R R T BRI, AR I R A A AR B ) B
ATEESAABER:

P3E:  http://www.gowinsemi.com.cn

E-mail: support@gowinsemi.com

Tel: +86 755 8262 0391
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2 zmn

AL EA AR E Sk FPGA 7 1 L B AR o I 1 — 8 4417 I
G, B P RE S LSk FPGA = S B AR M

*® 2-1 BiAER

%A

B

Zfe (Program)

¥ Gowin =R BAAE ) EL R BE 5 O\ B FPGA
W B Flash 58{3% 5 FPGA FHiZ 14 F SPI Flash 1)

lic & (Configure)

¥ Gowin z IR BAEAE B U RR IR B i AR
5N B Flash k3] FPGA [#] SRAM 174 X it

o

GowinCONFIG

BriEH M ITAG BLE RS, &5k FPGA 77
m SRR AN B 7=, B E R E, XG0
BLE, MSPIBCE, SSPI it E, SERIAL it #, CPU
B . FFakes 327 GowinCONFIG fi A%
DB R T A A RS AN e SR

HEZEE (AUTO
BOOT)

FPGA M\ B Flash szH ELAF i BdE R 17 e & )il
FEo RAAES RE M LR,

X )Eshiic E (DUAL
BOOT)

FPGA M & Flash 246 Flash 3B LR EE

BEATHCE IR, 2 IR S 0 A IAE N B

Flash f14MT Flash, =4 # 1] Flash Be & KM 1)
#2251k Flash BHATHCE . RA RS KR
L

FPGA ENFE24F (master), J@id SPI 1 FEEM

MSPI e H §135 Flash 52E0 HRE 7 B 70 8 f 7
SSPIELE FPGA 1E M E1E (slave), #MEEHL (master)
S5 SPI 5 115 A KRS 4T 1 B i 7
FPGA 1E M E1E (slave), #MEEHL (master)
SERIAL FoE S ER T4 115\ H O T I B 3
CPU BE FPGA fEAMNELE (slave), #MEBENL (master)

WA D (RN T 8-bit) B HURHR A
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A

B3

TR E R,

ZHEE (MULTI
BOOT)

MSPI L BB PIRTAEMES, 218 FPGA MR
Flash (AN [l ok sz B b R i b 3k 47 e & i FE
FA PR RT— AN EERR i 20 5 ON 5 — URBC &L 1 LRy
WMEHE N, 7EAR AN L A T JE 5 f
X RECONFIG_N P4 dmim s e i B« SCFF
MSPI fid B R 1 FPGA 72 i 35 30 #r s =X

RETF

HPm—FN 5, BIfE FPGA B3l TEfE, #
BRgF R, ol AR R BE B E
AN Flash #, JEidfilik RECONFIG_N B #7 I
B FPGA 24 Flash 56 ilc B 11

HIACHE

FPGA #F LLER AT I 7 AR UGE R R K —Fh 7
7o AT EUOMBE B 2R R O 2 AT I
A BRI BT 2 18] 4 REA% fan Bicdis .

AP (User
Mode)

FPGA e IRBCE R m, IR 2c 4
AT o, AEBERESCR F P AR 5 2258 s B S K 2

o
Ao

ID CODE

m R FPGA B fH I S ihsil, BRI
et BA AL 90 S .

USER CODE

Fi PR 8 CFHE 1 FPGA 2343547 1 B bRl
Al LLET Gowin RIS N BIZ I, Bminl >
¥ 32-bit.

@4 (Security Bit)

o AR FPGA 77 il i B 0 1) 22 A 1 BT
GEERY 7% a7 S VAR L a7 o W o S VAE 1= K Rk € 1
GNEIE, AR NHECRE JC kAT B [l S
SR ERIA AT FPGA 7= i (1) LURF IR 8 1
T ZEA

Jin# (Encryption)

GW2A(R) & 51| FPGA 7 fit SCRF IR, I i LA
WEIE SN FPGA Ja, &1FEAT 53 Sl il it & ]
ULHC, VGECHGE A BEAT s JF i s F s DLHECRIK
Ja g AT IR AE
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3 ECEE M4 3.1 P B B IS S L I

3 ECEEMITE

3R FPGA P L B ZHE, BAE ML JTAG LA T3
FLE. WaiCE . RATRCEMIFATRCESE, W LU 2 A SN AR 1
HRhFE R AR B SCIE IBE R0 e L B e, AT DL E N i)
/O, F ) AT HRHE SEFn s I O AT e . Pt ml ARSI TC B A A Th REXY
HREIEH], 2 SRR K

3.1 BEEEEMYIREE Rixm

3.1.1 Be EERHFIR
B 7ok Sk FPGA P i ST B S N % 3-1 Fir, £F s
VT AR A X D 0 A D A P e e R e A B R
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3 ECEE M4 3.1 P B B IS S L I

& 3-1 iLEEMTI®R
GowinCONFIG

B2 /0 KM | ITAG ’QSTO? sspl | mspl ggg} SERIAL | cPU
RECONFIG_N ! v v v v ) ! !
JTAGSEL_N ! v

TDO O v

T™MS ' v

TCK | v

TDI ' v

READY 1e) V v v v v ) )
DONE 1e) V v v v v ) !
MODE[2:0] I v v Y ) ! !
SCLK I v ! !
CLKHOLD_N/DIN | | v ) )
WE_N/DOUT o ) !
MI/D7 /0 v )
MO/D6 /0 v !
MCS_N/D5 110 v !
MCLK/D4 /0 v !
FASTRD_N/D3 /0 v )
SI/D2 /0 v !
SO/D1 /0 v !
SSPI_CS_N/DO /0 v )

!

o N[ARLSHEE B LR B A, R T AR S SR B S %
GWIN(R) Z 71 FPGA /i i FE L & FHHIGW2A(R) Z JI FPGA /%4 4 FE I & F A
o KT AFMER N THEMN E ESH 5 i BN H;
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3 ECEE M4

3.1 P B B IS S L I

312 EEMER

NEKRAHSE R 110 AR, w32 H FPGA 7 SCRPRBCEE
v E 5 E 11O . BT RF11) FPGA b5 A TAT Il B ERT, 5
Fic B AR 5 B RIS B A R OV BC B8 S P o L LR i » SR RE N P AR 2K
2 HE P P e 5 1) A P 34 T B G RAV A T

Varl |
FE!

R v B B LI, 50 R IR S B AT a RS A R i 8 F O BC B AR . XT3
Wi B, AT R R AL
Fic B IR e i an 2k 3-2 o

Sy FPGA #E M A 0R Mt AT 2ok

*x 32 Bl EEME HiLm
BB AR BB LI i
TMS, TCK, TDI, TDO 1E~%* Ffic B &1,
NON-RECOVERY JTAGSEL_N £ GPIO.
JTAGSEL_N 1E RN FH & &
JTAG PORT ® JTAGSEL_N=0, TMS,TCK,TDI, TDO /£
RECOVERY AT
® JTAGSEL_N=1, TMS,TCK,TDI,TDO 7
fic & 45 ) 5 1E N GPIO,
SCLK, CLKHOLD N, SSPI CS N, S|l
NON-RECOVERY ; o - =
ssP| PORT SO ENELHFCEE M.
RECOVERY SCLK, CLKHOLD N, SSPI_CS_N, SI i
SO 7L & &5 K 5 1E N GPIO,
NON-RECOVERY FA\STRD_M ﬁl\;ICLK, MCS_N, MO #1 Ml
MSPI| PORT 1E R T B &
RECOVERY FASTRD_N, MCLK, MCS_N, MO A1 Ml
ERCE 45 R A 1E N GPIO.
NON-RECOVERY | & HEC & &K
RECONFIG N
- RECOVERY Be & 45K 51N GPIO.
NON-RECOVERY kD P
READY R E &
RECOVERY Be & 45K 51N GPIO.
SONE NON-RECOVERY | & FIBCE & .
RECOVERY it & &5 5K 5 E N GPIO.
¥E!

e [1]4F JTAGSEL_N A& HRMEA:, FHAERR ITAG & HEH RN, il
- HHETH MODE [HiX E NIEH SN BB (RIEAEE B3 BUR3IA MSPI 0 &
Go A LU AR B S B AR, P L s Fahit T ITAG iEE 5, s fFiE N P st
X, JTAG & AN GPIO;

e [2]SERIAL A1 CPU Mt B A0 I i T 5 HAbBC B0, Bk st BN GPIO,
{2 240 S A R A AE R L i B A X AT B E N GPIO.
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3 ECEE M4 3.2 P B I Th B e 8

it Gowin IR ALEEHE M-
1. FTHF Gowin Z I HAEHAH R A%
2. TESRHFF kPR “Project>Configuration>Dual-Purpose Pin”, #1f&]

3-1 ;s
3. AJiesy LIk I G B R B AR
H 31 REEHERRE |
Wy Configuration I.iléj

| Synthesis I Flace & Route | Imal-Furpese Fin | BitStream |

Download Mode: |JTAG -

Use JTAG as regular IO
Use S5PT as regular IO
Use MSFI az regular I0
Use READY as regular IO
Use DOFE as regular IO
Use EECONFIG N as regular IO

0K ] [ Cancel ] [ Apply

32 i EEMThRE R M A

RECONFIG_N. READY #Hl DONE & il & & Fiitt 200 2 FH 21 )45 il
FA T B A I T AR AR R 1 O B A B P T

% 3-3 ERIThEE

B4 FR Ihaefid
TENECEE R, KBONEN, HA W L.
SR, 24T FPGA SRR & (5~ TR,
RECONFIG_N ${&E FPGA T AT 5 A
Aic B8R

RECONFIG_N TENECE S R, F5ZE— ANk 58 A>T 25ns

FIMIS BT J3 3 GowinCONFIG it B, [l gs b %
i MODE # & {8 & 37 in#k bR gz . B Pty LA
GINE CEEBLA bl =g N NTIE -4 A= E= E=P 113
AT AL E  /E N GPIO I, W AEFHAE output

KA,
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3 ECEE M4 3.2 P B I Th B e 8

B AR Thae g

inout RME . SHPFERL, HA READY Hi &t
FPGA 74 Rei#k4THC & #:4F , READY 15 5 HK )5 7 K
P34 F o akfih )k RECONFIG N ()75 2k &2 4R
==

VENBCE & T, % 4 output 254, 1] LLFR 7~ FPGA
YETRE R HATICE . AR B E KRR,

READY {55 s HEE KM, Ul READY 15
SAR AR T, BN input 288, H P RlE B 5
O AE AR AN N AP READY {55 PAZEIR AL &
AR, 1EN GPIO I, "JHI{E input 5% output 284!,

READY

inout XM E . FPGA BLE I EES, BE
R 5 DONE 15 54 & .

VE T B & I, 254 output 2578, 0] LT/~ FPGA
YA E SRR AT MECE RTINS, DONE {5
SN, SN TARRS; BB REARTE
oGfic B ST, DONE 15 SR EHEH TIRES. &HA
input 828, A ATiE B 52 s SR AMTE A
Fifik DONE {55 DLAEIR Hoifk N R
RECONFIG_N 5 READY {5 B IR A,
DONE 15 5 & REFEMCH RS ./ ITAG H
B SRAM ik, DONE 5 5 HEK A 5%
=X . YEN GPIO I, ATRI{E input B¢ output 2871 .

DONE

TENBCE SR, KA, WS Eh, &2
Al 3-bit /7 %% , GowinCONFIG fit B Rk 155 .
FPGA I H B FE P ik i %2 RECONFIG_N B,
A4 MODE {E it A FH M) GowinCONFIG IR
&, A SR EA R Y1) FPGA 77 MODE {E X}
MODE G B AR RS A AN, BT 275 A B A A 1
FRECE FM. BT E I E A E,
BB MODE &I AR e A H G ok, REHE N
K] MODE % JITE #8143 C3etth, BARTEZH A
Mg PINOUT F . MODE & iI{E A GPIO i,
HEEHAE output 287!,

YENECEE R, RACRMAN, Wss . Wi
TE=ETRHHIRE T ITAG EFHER N GPIO, &
P JE AT — IR IR B S JTAG & AR N
GPIO, JTAG FCEIhReRRL, H A it Hifi
JTAGSEL_N 4TS ; WHRH P KR %E ITAG &
JTAGSEL_N ISR, W JITAG BCEThEE—HE T H. 1E4 GPIO
i, AT HAE input B¢ output 287,

!

JTAGSEL_N 5 JTAG FCE 1 4 MEH (TCK. TMS,
TDI. TDO) W E N GPIO W AA7EH /¥ XK &: JTAGSEL_N
WE N GPIO K, JTAG &M HGEEARCEEM; JTAG &
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3.2 FEE IThaE XM
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B AR

Thae g

I E Ny GPIO I, JTAGSEL N W AE/E M & & I .

TCK

TENBCEE I, KA.
JTAG FLE B M BT BN E . /E8 GPIO
i, B AR input B¢ output 257,

T™MS

TERTLEE W, RACNRIAN, WHEss Bhi.
JTAG Ml EBA R AT ANE M. /£y GPIO
i, B AE input B¢ output 257,

TDI

TERBLEE N, KA, WNHEs .
JTAG Ml EBA R BEAT BT MANE M. /£y GPIO
i, AR input B¢ output 257,

TDO

TENECE BN, KA .
JTAG Bt BRI R ATERE R HE . 1259 GPIO
i, w]FAE input 2% output 257,

SCLK

TERNECE B IR, KA RN
SSPI. SERIAL F1 CPU Fg & 5 =X ) i 8 N8 D
YE25 GPIO B, w]H{E input 8¢ output 2571,

CLKHOLD_N

ERBCEE N, KA, NS .
SSPI 1 CPU [t B R AP B & . “iAN s
HLSPI, SCLK 0 REERAER 25 G4 N K T,
SCLK 5 B (44 F Jo 8% /28 GPIO I8, AT FHAE input
B¢ output 27,

SSPI_CS_N

TERNBCEE I, KA AN, N5y Ehi. SSPI
B BRI IS5, (IKH- A 2. 1N GPIO K,
Al H{E input B output 2574,

Sl

TERBLEE I, KA HIN . SSPIiC BRI &
TRARR NG . /58 GPIO i, w] HI{E input 2%
output 287,

SO

TENBCEE I, KA i . SSPIC B &
THEIR S . 1N GPIO i, B FHE input B¢
output 87,

MCLK

TENBLE S IR, RACHHIH .
MSPI e E A ) B B, RIET FPGA
AR, AR A AR VG L 2.5MHZz~125MHz,
BRiAH A 2. 5MHz, MSPI B B AR AR S HF
125MHz 8. 0T N ER IR B 4R B 16 2 %5 A
IS 2 A () A T 0
P A = RS A2 0 MCLK BIARZAE, 4
3-2 ffin: TR TR, e igss
“Project>Configuration”, H.i; “BitStream” T1%%,
7t “Download Speed” THi4|FKH ik MCLK )
B . 1FN GPIO I}, A FHAE input B output 2§

it

MCS_N

TENPCE IR, SRARDYHH
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B A FR Dhfethid
MSPI Bt B AL AT ik ME 5, KA 2 /E 8 GPIO
i, B AE input B¢ output 257,
TERBCEE I, KA AN
MI MSPI i B AR AT HAR AN E ] . 1E8 GPIO
i, A AR input B¢ output 257,
TERNBCE S RIS, FRADAHH .
MO MSPI P B AR AT HR M HE - . 1F9 GPIO
i, B AE input B¢ output 257,
TERNBCEE I, AN .
MSPI fic & % 32H SPI Flash i# ¥k (55 X4
FASTRD_N Ay P 8 5 i BB X (F5 4
FASTRD N 0x03); 24 FASTRD_N A HL P B Ay ey it s B =,
FATXKN Flash g BURETR AN, BARS
ZZAN. Flash )% T0. /v GPIO If, FIH
£ input 2% output 27,
VENBLEE IR, RACAHN .
CPU Mt BB A 5 RS S I FEM: 4 WE_N
WE_N N HP R RN AR 2 WE_N K HFR R R
EH#AE. E4 GPIO I5f, ATHI{E input 8¢ output 28
,
inout SR
D0~D7 CPU Pt B A A it N 7 I, 8-bit Az%8 . 4R
P WE_N HIE#HE DO~D7 i NGt 7 m. 1EA
GPIO K, =] H{E input B¢ output 287,
VENBLEE I, AN, WS Eh.
DIN SERIAL Pt B AT BRI E . 18 GPIO
i, AT HAE input B output 287,
TENECE & RIS, RADAHIH .
DOUT SERIAL [t B =0 sf AT B fan HH & T, R AE FPGA

R ARG — et r%iA . 1E8 GPIO I, 7]
FHE input 2% output 574,
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3 e & & A4 3.2 e B & I Th g M N

[ 3-2 MCLK $i%i& & :
Wy Configuration M

| Synthesis I Flace & Route Imal-Furpoese Fin BitStream |

Enable CEC Checlk
D Enable Compress
D Enable Encryption

Ke}' U‘[ex:] lano0ooooo-0o0000000-0000a0000-00a0a0000n

Enable Security EBit

Download Speed (MHz): 2504100 (default) |

250430 o~
SFI Flash Address: 032

250734

USERCODE: 25036

250,38

250,40 .
Ze0/4z
250,44
250,46 o
ZE0,/100 (defanlt]

| K ][ e ][ Apply

UG290-1.01 12(34)




4 R ST 4.1 PO B B

L cssmsen

iz P AR Oy DRI C B O ) 2 e HER R4, A2 FPGA 77 i B LRI ST
PERERAINA T CRC BB SHVAIF W E 1 L. Bl id B A Se R e
NBE RS A, BRI M BE A F, DONE {5 53k, WHE 1%
AL PRI AR SE B EL R, AR P VA AT Rl A

4.1 BCEHEME

5K GW2A(R) & 51 FPGA 72 i S R LL R BT I, KA
128-bit [ AES Jin % 515 . I P E Gowin z J5 A S i i N N3 4 (KEY),
B 2 AR s P B B AR RN S B LR e, I I LR IR O A 2 2
Ji, FPGA 2R 35 e fr NI 255 2 S AE 04T e B HGR i Al, e bi T /5 5%
R E SRR, AT RMUS READY A1 DONE {5 5 RifK, S JCikiEw Tk
FE IR HA B NI B H R TR T
1. AT RS TR A B ) A%
2. TEEHFIFIEFE “Project>Configuration”;
3. Hii“BitStream” 125, 2) 1% “Enable Encryption(only support GW2A)”
HAmANEYME, ik 4-1 Fos.

UG290-1.01 13(34)




4 R ST

4.1 Fie B 33 n %

UG290-1.01

EE 41 MEBRRESE

Wy Configuration

? et

| Synthesis I Flace & BRoute I Imal-Furpese Fin

Ensble CRC Check
|:| Enable Compress
Enable Encryptionfonly support GHEA)

Key (Hex]: 00000000-00000000-00000000-00000000

Enable Security EBit

Download Speed MHz): (2504100 (defamlt] =

SFT Flaszh hddre=s: FFFFFFFF

ISERCODE: uluu]nluu]nln}

BitStream |

I

TN H B o BRI i » 3 T R 13 B 5N B FPGA [ B X
SR RERAT IR B0 EE SRR 2080 5 BUC

R AN BN IEIR

I Gowin ZmFE A4

14l FPGA 28145

i B 2R E % £ Configure Security;

FE SR B0 S T A N TN B AR B write RS N2 FPGA,

K 4-2 s

B 42 REEPRESA

W Security Configuration

? |-

wirite ] [ read ] [ lock
Lock ! Befusze for writing and reading
Read : Display the key(when unlock)

Write : Frogram the key to FPGA

Close

s

-

=)

i S S N R Ja PT DA B S SR 4 Rl 5N P HEAT I

14(34)




4 LR S 4.1 Fie B 33 n %

UE . 25 NI G, F P a5 lock a2 K5 5550 “8i48” 78 FPGA W3,
ZJEARAIN B A B S O BN R BRI B, S
FHIE M “17, RWEMESAE, s LR R R A 5
FAVCEC RS Jo A Be el . RN LeRrim 2 s i IC B AN 2 25 5A 520

!

iz SR FPGA WIS VI E AT A A1 4388 0, Mt B B M = — B S0 1 58 ok
5] 0. 51 1, P () 3R U4 o 5 N (1) %5 8H /5. 25 00000000-00000000-00000000-00000001
2 JEAE U B B A N R AL A A 1.
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4 R ST 4.2 TR B ST KA

4.2 BER BRI

m TR FPGA 7= i B AR B a0 e ik fikg X, = A4
B fE 284408 fs BSCE =2 SCAMS S, P AT DS w2 3k Ak o 1 3 4 T B
HotE ARy iR A% 2
1. TJT Gowin 4mFLitt,
2. BdiSEHAY “Tools>File Converter” #1770 T A,
3. XhAHK “File” EF 7R B U IR B RAF B8R, A N A

“Convert” {83474, K 4-3 Fros.

[ 4-3 ELAF R R TR

W File Converter o | B |t
Conwert to: [BIN V]
Save file as: D:fsoftware/Gowin/1.7.2.01/1. bin (|

File Size(bytes) Device Checksum SPI Address
1 Dv/software/Gowin/1.7.2.01/work/test_pllfi... 577160 GW2A-18/... OxCOFD OxFFFFFFFF

o SRR R B B B 4, B 4E LB 5 H P BB A, A
PR AR 4 T B S RN, anER 4-1 B
= 4-1 B =¥ 54k FPGA = REESTHEA N

a4 AR ML E SR/ (AE EBR) R B XK/ (B EBRD
GWI1N-1 42 KBytes 82 KBytes

GWI1N-4 142 KBytes 216 KBytes

GWI1NR-4 142 KBytes 216 KBytes

GW2AR-18 563 KBytes 886 KBytes

GW2A-55 1393 Kbytes 2268 KBytes

!

o [LJHAh i Y E B SO R/INE Ja BRRRAS T 5
o [21RTIHE R R ST RN, IF B E SRR BEAT R 4 -

UG290-1.01 16(34)




4 R ST 4.3 BLE LI E

4.3 LB ixRINEE

& TR FPGA P2 i Jw R B OQ R VE 75 B 45 IR i A T 1 T
T B DAAE RRIE A 04 AR 0

WO LA FENC B R A A S 13 TR BU AR 7T 5CHE A BSORH S R e T

it & & S AW E T iEES % 312 B EHER.

e & B A S W B R iE S % 4-1, ETIEHE CRC /IR, Lhks
WMEYE AR IEEHKE. ZeMNE. MSPIBLEMZR LR, LHAE
#i30 K SPI Flash Gzl #% & . USER CODE # &%:. SPI Flash J& 5
HHAR 12 A TERk, P T E /2 ADDR[23:12] 1 Hutik 25 (1]

VE

22 AR 2 BT ) 1 5 5 1 B S L R ) 20 10 22 A U RO, P R L
R EATRCE , R DURIE SR R 22 4, SCRENE B LE A T [ e 0, BRRR T
AR T P ORI 2 A

UG290-1.01 17(34)




5 Fo B AN 4 4.3 BLE LI E

5 L ERNTE

oS4k FPGA P2 i & 36T SRAM L E ) GW2A(R) & 41 () = P B
AR Flash (1) GWIN(R) &7 /N &R S Rt . T SRAM T.E
)28 A LS 2R N I BC B A A2k, R EHE RREDHTCE ;s Bk Flash
(PAE 5 2R A A S BRI SRAEAE A0 N, E0F i mT DUE TS H 8 30
B B B B C B 77 20 28 F B Shidi AT R E

mat TR FPGA = 3R E, —FE 2 SRR B AL
X EHREH RN E S W E AR raE SR CRREHMN ITAG iE; R
FIEZ KB H B shE S shlic B ; FF L BB MODE B %5 A [H .
!

KT GWIN(R) R & GW2A(R) & %1 FPGA 77 i SRR AC B AR 3 K B B ERIE ) 3 5%
(GWIN(R) &%l FPGA ;=i 4ufEfic & T M) K (GW2A(R) R %1 FPGA 7= it Ja F2 it & F- 1)
3 g FER B AU

UG290-1.01 18(34)




5 Fo B AN 4 5.1 i B AU

5.1 BCE

Bz SR FPGA 7= H T2 8 GWIN(R) AT GW2A(R)F KK ik, Hrk
GWINR)F & GWIN-1. GWIN-2. GWIN(R)-4. GWI1N(R)-6 Al
GWI1N(R)-9 &%/ . GW2AR)ZKEH & GW2A(R)-18 Fil GW2A-55 1
ZA. LT RBES R AW ERHE, FEXHZW R 1 FPGA
NI EER T SDRAM.

Fz 3R FPGA 77 i 44 HREC B 500 I A7 i AR 2 IV F A 43
SRAM [J#AE. XTI E Flash FIEEERINTAMEE Flash (e, Heb, STHE
Flash [#:4E R GWIN(R) &1~ 5, % SRAM F14 Flash [r)4F
B 7= i3] SCHF

%7 SRAM [ /E L% B 28 ID CODE H1 USER CODE, ZHUZR {1k
SEAHRERLLL SRAM L E . #34F ID 32l B B Er R, JfA ID 5
WE LI 28 4F A B i1 TG E ;. USER CODE & A4 J7 18 H J' %} ID CODE #H[H]
(I Z A28 CAIX 23 BEAT I 5 b il s S8 FPIRES A A a0 6 FPGA it &
BIERPIRSE S, H PRI T8RS, IRESTFAHRN S ESH
(Gowin Programmer /4 /75 % ). SRAM [ B HAEN FEE Y E, HAERK
B N RS SCRF IR ThRE . B T e A BB AT AR A P e
A7 [EEE G AIE o

TN B Flash /R LR R BRFIRFE DL R I g R NI IR ER A .
HAEE JTAG # L #1/E N B Flash, 4P R R # 4 2MHz~2.5MHz.

i H N & Flash FLE SRAM [HE (HEZNECE XS shECE ) AP E Flash gmf (e
IFEH FPGA i ZORFF B HUIRAS I HANGER Tl RECONFIG_N, AT RE X A B
Flash i& AN ] 1& & A

N & Flash M ZmFEi6 AR E SRAM #REZ AI5E i, BB SR E T
e L DAINE A€/ WP CINEE ral]

XPAME Flash BUERAEQFEHERR . gt DA IR A gatE . A58 Flash #:4F
Hi ¥ MODE AE I E Y “0117 ARAHA K fe -~ ik i /< RECONFIG_N
BUH T FPGA EH . BRI Flash, (FHZ ERLEH P
BHNZA LR A I 75 ZR A S B R I AR A

P AN AR BN, 5 2R Em & WIER, #ifk FPGA T
EAE I FE L BN o P e A8 H AN & iF s mT DLid e oA b2 07 X
RIGAE IR LA A, I OR B SR AL A o< B E IR AT . MODE[2:0] FH ki #%
GowinCONFIG [ ZmE it B, AT E SR UN A] AgH Edr el
Fir 17 W FL I AR A, R HHAERE 47K, TR A BHAETE 1K,
E!
RECONFIG_N. READY #I DONE & {5 &M B UG, it P 2SR ElIREN
GPIO, # s BARAIETE AL B 3 1 58 BT S AT 6 (i B0 IR B DR 4 W A o P L L 4 1

FH P 34T e i B B s o iy, HEFEBRE K] 5-1 B

[m
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5 FE B AANH 5.1 it & 24

& 5-1 ElE EMHEEREE

DC3.3V {] MODEI0]
| MODE[1]
I MODE[2]

FPGA

u}—({ RECONFIG_N
KEY

READY | DONE
DC3.3V 4.7K > DC3.3v

/7 />
LED LED

Varll |
FE!

o P THEEMA MODE {H I AT G N4k 5¢; #5214 MODE & A& 5¢ & d 3 ok, &
FHE ) MODE & JH & N H5 42 b 5

e JTAG FiL & it f#H READY FI DONE 15 5 MHEA S H = X;
e RECONFIG_N. READY HI DONE 53¢ R i) i O A i Ab 22, ANz e B D Rg .
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5 Fo B AN 4

5.2JTAG it &

UG290-1.01

MODE[2:0]#{E 5 Fic B AL 16T B ¢ R WIER 5-1 Fias .

% 5-1 iL EEA M A MODE {&

B B 15 GWIN(R) | GW2A(R)

JTAG XXX XXX
AUTO
BOOT 000 XXX
SSPI 001 001

GowinCONFIG '\D"SE'L 010 000
BOOT 100/110 XXX
SERIAL | 101 101
CPU 111 111

Ve

JTAG L E#i5 MODE i i2%, GW2A(R)#&4IASLH AUTO BOOT il DUAL BOOT.

GWIN(R) £ 54 M #hIE R #) DUAL BOOT, GWIN(R) &4 FPGA 7 ¥ % # MODE
{4>4 100 ) DUAL BOOT #x, {HJ&H4 GWIN(R)-6 f1 GWIN(R)-9 #3137 MODE 14
4 110 ) DUAL BOOT #i =,

5.2 JTAG B &

!

*xT ITAG fic B i 7 B KA om RS0 15 2 72 % (GWIN(R) &% FPGA 7= g fE it

BFMY & (GW2A(R) A% FPGA F= M4t fic & F M) A 5 Al B =NA4H.

F 5K FPGA P21 JTAG it BT 4 IEEE1532 R Al
IEEE1149.1 i1 FL T HbRuE
JTAG Pt B 45 e B LhRr i i 5\ 31 & = 2 54k FPGA 77 i i) SRAM
W, BHEGEEERIEER. RS IrE HEN FPGA 77 i FE JITAG

FLE R, IJTAG BCEM A MAHSE K 5-2 .

# 52 JTAG B BEEAEMENX

(=g B /0 28Y Tt B

JTAGSEL_N LSS g ;.;ZTAG EHM GPIO K N E &, (K-
TCK? | JTAG HATH BN

TMS? |, B 55 4 JTAG HATR A

TDI |, s B JTAG B AT H s N

TDO o} JTAG 4750 %

e

e [1]JTAGSEL_N {55 154 JTAG & E N GPIO I H 23415 8h TAE G AR /ER
e [2] TCK FH#E PCB LifE#: 4.7K Nz AikH.

21(34)




5 BB R/ 4

5.2JTAG it &

JTAG PORT

TCK
T™MS
TDO

TDI

JTAG it B A e L R WK 5-2 Fiw.

B 5-2 JTAG e 2R EEREE

FPGA
3] JTAGSEL_N
JTAG PORT > TDI
TCK
T™MS
< TDO
Ej
\l
~
P!

XtF JTAGSEL_N AREEE ORI EAE, F P AT ITAG &R KRB, @il b
HLHTR MODE i B VAF A S RCE B (ARSI XURBIA MSPI) i % HoAt ELy
AR E R, A BT aiAT ITAG BLE )G, SFHEAR A, JTAG

BHA A GPIO

JTAG Pe B AR U B AR A

fem T 40MHz.

B T HHTHE M JTAG FLE SRAM #1E4h, B 3R3ES) K FPGA 3%
£ (GWIN(R) %71 1N & Flash F1HAB A R4 FPGA 7 & F1 7 SPI
Flash M w2 E L mTiEId JTAG & AT . JE5 KE1FN E Flash 4 fE
BEIEL N5 ITAG Bl B UHIE, 4 SPI Flash gmfEifEiE &% K
5-7,

AN, m w2k Sk FPGA 772 5 S0 Er JTAG ZickiefE, B, 38— FPGA
[f] TDO & %33 T —A FPGA (1] TDI &, Gowin ZmfEi i< 3 2R 5
HEREE 1 FPGA 234, MKUGHATHC B - 29 16 BEAC B )& = K in & 5-3
iR
B 5-3 i HREER EETEE

FPGA

TCK

\ 4

T™S

Y

TDI

A

UG290-1.01

Y

TDO

FPGA

» TCK

» TMS

» TDI

TDO

» TCK

» TMS

TDI

FPGA

TDO

:
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5 Fo B AN 4 5.3 HHBICE

5.3 BERTIEE
E!
KT H A L E N 7 B B R R S S 5125 (GWLIN(R) &% FPGA 7= fh g FE AL
BHFMY K& (GW2A(R)#%| FPGA F= it ZwfElc & F M) = 5 FE BN H.

AEZAl B, B AUTO BOOT BL B, &z ket xt
GWIN(R) R F14E S 2% FPGA 7= i (1) 5 iy B2 1 AR5 1 4 0 1) — P EC B A X
GW2A(R) %1 FPGA F= i A FFH RN ER . BRIMEAT, Ok
WG R M RL B B2 0, FPGA RIRJ 347 WA B Flash S2HLEL R 5ds
SERACE -

F P B JE s, e 5 Bl JTAG 2 S B E B g fE 21
FPGA [fIN & Flash #1 (=% JTAG BLEH NG REE, B 5-2), A5
‘1 MODE {4 “000”, 4 A% b EK P ik fid &2 RECONFIG_N
BRI, O 2 B3l B LR A e R BL B I AR . H PR MODE (HIXE N

“0007, i Gowin JmtE B mtEN B Flash 4515 FPGA & HBIILE
SRAM e H JE 3. N B Flash (1) 5% 28 R 9 e B #2720 1 R 2],
fem T TAERCE.

LT GWIN(R) 41 i Hodth FPGA 725 L a R BE S — ik E B Shi
B/, GWIN(R)-6 Al GWIN(R)-9 FPGA L E MK H G E, B,
LS BB ShECE KM, #E e UL E ST IR E T B E . TR E
R R R ALFE ID B0IEET 1%, CRC RIEGE R R S5 R
!

W Flash 1 AR AE— O ELERA SR, 0B B Ui R e .
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5 Fo B AN 4

5.4SSPI fit & A2

5.4 SSPI Bt EE =

UG290-1.01

¥
KT SSPI BLE W7 B KA 7S5 1 70 3 2% _(GWIN(R) £ 7 FPGA /=i i F2 A7
BFM) Fi (GW2A(R) FF FPGA /i i FEf B F L) 5 J B A2,

SSPI (Slave SPD Bl &R, Bl FPGA {E M 284E, B4 Host it
SPI £ 0%z - 4k FPGA 7= it AT e B it A2 . SSPI B XA S AL &
BN 5-3 Fiow.

%% 5-3 SSPI BeE#EREM
B AR Mok 3} i
l, e _ _
RECONFIG_N B | RH kb 53 GowinCONFIG Fit &
T HLF e Y ET A LLY FPGA #H T 4mfEid &
READY Vo (s 25 1E% FPGA T4 &
DONE Vo T RIS R R
TRH T R 58 g AR AC B B g A I B O T
. , =) WL SZ A
MODE[2:0] oS Ly fid Bk, READY _ETHL AL
SCLK | LOPNINEL
1, LT SCLK XM SPI #RE A %L
CLKHOLD_N WSS R | {RHF: SCLK X RIAY SPI T
SO o) FPGA % i #0431 Host
Sl | Host 7] FPGA i A\ ¥
I, » 2 S 75
SSPI_CS_N 8 | SSPI k(55 , MKHE AR
¢ H] SSPI Bt & A 250 & =2 S48 FPGA 77 fhlic B iR = B i E
5-4 Fi7Ro
[#] 54 SSPI Bt BE{=X EIEREE
Host FPGA
CLK »| SCLK
DIN |« SO
DOUT » S|
CTRL » CLK_HOLDN
CS N » SSPI_CS_ N
V)

ILE SSPI L B MR /N R4 E, SSPI KR MODE i “001” , HoA [l 5 & o 4
Fi 2% K 5-1.

SSPI Bt B & I 737 H A SRAM FE B HAEAL, BT 92 FPGA 4h
E3f) SPI Flash, 4wfE Flash #/ER) MODE {85 SSPI it & % ) MODE {4
FHIA],  FH AT BAPE Gowin ZmfZ i fF Hh ik B ic B 3P 5 N\ SRAM B0
Flash. SSPI 304 fE4ME5 Flash 11343 R 2 KW E 5-5 .
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5 Fo B AN 4

5.5MSPI fit B 1 =

UG290-1.01

[# 5-5 SSPI 4x#25M B Flash EEREE

Host

CTRL

CLK

CS N

DOUT

DIN

Y

Y

Y

7E!

FPGA

CLKHOLD_N

SCLK

SSPI_CS_N

Sl

SO

MCLK
MCS_N
MI

MO

Y

Y

Y

H A1 GW1N(R)-6 fll GWIN(R)-9 #&1F % ¥ SSPI 4i f£4M i Flash.

5.5 MSPI fir Ei&E=t

!

Flash
CLK
CS_N
DOUT

DIN

FTF MSPI FC B I 7 B AR P S E0HE 2 7 2% (GWIN(R) &4 FPGA 7= g FERC
BFM) & (GW2A(R)Z% FPGA P~ el & F M) + 5 Bl EHRN4H.
MSPI (Master SPI) At &z, Bl FPGA /N3 2844, it SPI 0

B MHME Flash S LERFREEORE S R BC E 1S FE . MSPI B & g A2 :

1. % MODE % {i% B N4mfEsh i Flash JRZS, ¥ FPGA ¥ b K P
fik it %2 RECONFIG N, @it JTAG 2 [ B X 2w FE 2445 Flash
R

2. ¥ MODE &I E N MSPUIRE, KPRk it RECONFIG_N ¥
b, 2 EAT WSS Flash 3B LR B GE, 52 id Bt Fe .
R4 MSPI EC B R, H P T PLSEILERA R FR: 24 FPGA B3]

TAEE, HAFEFER, HP LUK EC E B 2 5 N FPGA 43 Flash

e, Y BT 4 i ) RECONFIG_ N BREE 7 F A R4 58 T2 .

!

MSPI Fic B #2008 % 75 5% B A MODE 18 (4w L4156 Flash AIM Flash 3R>, A1)~

HEAT IR A v I 75 22T B MODE {ELI I D e 5
MSPI#xC, AL S B E AR SN Flash, BARTNEWE 2% 7 QR 171 HE .

MODE {H A7 D14, AT [
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5 FE B AANH 5.5MSPI it & 15,

MSPI A5 XA < OB B & 2 5-4 Fiow.

% 5-4 MSPI Bt EEA ERIE X

A RR /0 2KHY i B

RECONFIG_N Ilj’ﬂ e |y RSP 55 GowinCONFIG Bl &
L AT A] UG R AT A B

READY o IGHT A8 1 B AT P

DONE /O P BIh e IR R T B

IR R 5E g R I B g P B R T

MODE([2:0] smes |-y | MODEEFE(E'S, READY LFHITREE

MCS_N FIEE, AR TR

MO FPGA i i % d5 2| Slave

M
MCLK o FPGA % ! i
0
0
|

MI Slave fi A%z 2| FPGA

READY 155 LW KRR
FASTRD_N | iy P 2 3d Flash o7 ) #52 CR A Flash 132484 0x03)
K HEF: =ik Flash 15 i # CR A Flash #2454 0x0B)

!

MSPI fit & B I B AR AN BE KT 80MHz, AR 8 AR KT 30MHz i) 75 Zd F Flash f5=
T ) AR 20T AN R R FASTRD._N B il B 80456 A =T 30MHz i, FASTRD_N & il &
AN,
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5 FE B AANH

5.5MSPI fit B 1 =

UG290-1.01

5 F) MSPI it B A0 5 =2k 3k FPGA 72 S i AT i B 1 R R & K

Kl 5-6 FT7K
5-6 MSPI L BN ER T RE
FPGA SPI Flash
—————» FASTRD_N
MCLK CLK
MCS N CS N
Ml DOUT
MO > DIN
!

I E 8 MSPI B 1) 5 24 B, MSPI B MODE {5 GWIN(R) A “010” , GW2A(R)
N “000” , Emlﬁ"’“ﬂiﬂaﬁ%ﬁzﬁﬁé%@ 5-1. MSPI i & #2045 T 30MHz I
FAST_RD & JHim &

i JTAG 3% DTEEEE%&TEEE%U%*K Flash #8fFHIIERR B lﬁul
5-7 Fw, @it JTAG %Dﬁ%ﬂa%mﬁ Flash 75 %1% B 7 € ) MODE {H, 1
M e A g AR B T . i SSPI 2 R4 Flash HiERR & IEI
2% K 5-5,

[ 5-7 JTAG #EO4F25MEB Flash BEREREE

FPGA
Flash
TDI MCLK » CLK
TCK MCS N » CS N
JTAG PORT -
TMS Ml < DOUT
< TDO MO » DIN
SN
X
El

BN ITAG i M4mfeshil Flash f)f/h &4 K, MODE {HEE N “0117 (i
ife b Flash AS245:0 MODE {8, JUAl[S & & W #5152 % 18 5-1.

oS FPGA F7 il i B2 5 SRR — I E 3 i MSPI L E #5245,
GWIN(R)-6 Il GW1N(R)-9 1 GW2A(R)-18 R 1|77 fhE M 5 T #EAT 1 B3
PR GW2A(R)-18 #7%1 FPGA X FFHE I — XL EH#AE:; GWIN(R)-6 F
GWI1N(R)-9 FPGA S HFE AL B 3. G MSPI FC & R, #4
A DA% B SRR S B Bh g AT BT B R . 5 B R R R L

L AR
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5 Fo B AN 4

5.6 XUn shfic &

ID B8 iE45 1%, CRC IRIGE R AN TR 245 1% . H - o] LLFE v B B e E 1Y SPI
Flash hilik, #id Gowin = FHE N . X —ReME R R FEE 1 HCE KM
IR, A P TSRt 7 5 i Ay SR M R
ZEHEE (MULTIBOOT) & MSPI it B U AT AEM S, &8 FPGA
MIFE— R4 Flash AN A sk s B bR 2 i T RC B i A2 . H Al
Programmer 34 SC RREAERER PIE 00 4 2 > EURFAL B0 R IR G A2 21 4150
Flash 1, #ltGgmfEthl 0. H P fERT— AN ERRm e B 5 N G —IRC & 1)
PR B B gk o, FESME AT B 5 0 N iE i fil % RECONFIG_N 1]
PR R SO S AL B . S MSPIE B U FPGA 77 i 2 SRR
e
o [1|ZHAEEFHEANEBEKEN Tk RECONFIG_N #HTHE B HIE I H, #/FHH
Ja e stk iE %
o [21H /- fH £ HEIC B AT U R LR A RN RS BB A 2 B T — AN LU
T 78 5
e [3ISPI Flash ja sl 12 A7 ok, H - nlix B K2 ADDR[23:12] /) Hikik 7% 1] o
b 7 FIR AN HE)— F Flash Bt & — i FPGA B, & = 3 1K1 FPGA
PE SRR Flash it B 22 /7 FPGA ()15 %i: 5 SPI Flash BLR2FHIE)
FPGA Z3f4 K H MSPI it B, HAth FPGA KA SSPI & SERIAL B & 15
o BARMEAE T B EMASHATE . E4r2EWE 5-8 Fis.
V!
B B 4 7T 75 22K 4HOC FPGA 1) MODE fH %5 MSPI #1 SERIAL A B A 7 /2 MSPI
I SSPI BRI . 82 L SR FPGA 7= MRS I Flash LB R — )7 FPGA 1
Do
[# 5-8 —F Flash Bt & %/ FPGA E#ZEREE
TBD

5.6 MBEHEC E

UG290-1.01

MBS E A, B DUAL BOOT it B, /o F3k GWIN(R)
ZHAE S K FPGA P= i SR — i B 0. WS s EAR AN, FPGA H
FIEFEN N E Flash 835 75 Flash SEEL LR SR 52 AL E . XA Shfic &
BT EE PR E Y MODE 15, MWE Flash B3 LaishaiEsk, MAMT
Flash B shffiE 277 %5 MSPI BB B XAH A, 2% 1K 5-6. XUE 3IC B AR
AR T AL E AR, B rT DRI E B 75 SRk R B O 1 A 6
A=

GWIN(R) & %1 FPGA SZRFF A 77 s XU shFC B2t GWIN-1,
GWI1N(R)-6 1 GWIN(R)-9 #4f+ MODE &4 “100” I, sk N E
Flash J53, 4 & Flash it & 2, #2443 E04h 46 Flash HEdE#E4T RS
BH; MWNE Flash N, SSEAATERERERAE. BRikz 4, GWIN(R)-6
A GWIN(R)-9 #8443+ MODE 1y “1107 W}, g81h-4 26k M AMEE Flash
Ja8)), MAMNE Flash BCE R, S8 FE SN B Flash 4TI
B; AN Flash AR, S¥EASTECEEE. XA shic B =R i i i
5-9 AR
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5 fig B A A4 5.7CPU it &%=,

& 5-9 Wa sl R RIEE
( start ’

<
<
4

A
( end )
V!
N MODE 1B “100” B XU ZMECE 2R . MODE HIXE N “110” K FPGA 1t
Seik B M AN Flash B30 .

%FF GWIN(R)-6 F1 GWIN(R)-9 &A1= 5, Toie & MR = i) SUs 3
BLE, FPGA ¥SCHF 4 IRBLE 22 ILEFRNAAMEERR R8N 3 Ik, 3 Ik
KRG IERE 5 — N TECE . W E Flash )53 R AETFLAT 0 Hutik;
MODE fi >y “110” i}, MAMEB Flash JE3hHT 3 kR AT LU B E 1 5 5
bk, JABHEE R ETE S VRS N R AR, SAME 3 IR E
FARAR M) 28 kBN B Flash JE 3.

VE !
SPI Flash & 2t hkA% 12 7762, H 7 Al E & ADDR[23:12] 1) ik 73 [H]

GWIN(R)-2 Al GWIN(R)-4 #&4F H i i A SCRFE84F 3 sh KRS S BCE
ma SO PR T XSV I E T %, HAHEERESETF
W (FFE L824 GWIN-4 &4 7 DUAL BOOT F#7%).

5.7 CPU BCERR

CPU Bt B0, Hostiid 8-bit {7 % HI B & 48 1 X iy = 2 4K
FPGA /" THCE, CPU ML E A E N 5-5 B,
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5 FE B AANH 5.8SERIAL il B 1=,

% 5-5 CPU BLEEAEM
TR T
RECONFIG_N ;iWﬁ@Et (RSt %) GowinCONFIG /it &
T ] D R A E
READY Vo (EHP: A5 1E 0 S T SR
CONE o BT T R E
EH T e P R T ol T L i
MODE[2:0] %W%%L KB U5, READY | FHISTHE
SCLK | NI b
[, WEBgs E | mH P CPU #1EH 2L
CLKHOLD N = T CPU HIETE %
B e
WE_N | 0: B
1. ik
o70] o B KR TT: CPU A LR U (i N
' B, L G5 o e T B A th AT 50T

CPU Bt B A i & e = B W & 5-10 Fiors.
[# 5-10 CPU EE 2R EEREE

Host FPGA
CLK »/ SCLK
DATA |« /8 » D[7:0]
WE_N > WE_N
CTRL » CLK_HOLDN
!
@?\j CPU it BB/ R 48, MODE {18y “1117, HARME & & H#EES %
5] 5-1.
5.8 SERIAL Bf E&ER

SERIAL Ao & #3X, Host it #2478z 0% & =2 S48 FPGA 7= it T
H. SERIAL M &GRS EE &M ER . SERIAL BB
Haeks LR AR 5\ FPGA, ik FPGA #34 [Rl 3t ds, Kk, SERIAL
fic, B A 20 5132 HL ID CODE A1 USER CODE LA JUIR A 17 885 B . SERIAL
B B A ) & A LR 5-6 T o
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5 Bt B AR A4 5.8SERIAL it B #i s,
%% 5-6 SERIAL i EERERIE X
B4R /O 28 i B
RECONFIG_N ';;j'j‘] AL e P kb, %) GowinCONFIG FlE
S AT DU S T AR B
READY /o HLF: LA PR TR
- /o L T R A R B
MRS SR 58 g R e B 2 R i B 2 I
MODE[2:0] WAEEE | mptie s, READY LA
SCLK | BN A
DIN IHW LLRERS N
DOUT o) W EAE, RAT FPGA Z0EH SERIAL MiE B A=,
SERIAL At & A E R~ = B 5-11 Fis.
5-11 SERIAL B BEER EiEREE
Host FPGA
CLK > SCLK
DOUT > DIN
7
KA SERIAL Fe B R RN RS, MODE {54 “101” , HAb[E & firEEiEsk
5-1.
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6SPI Flash 1%+

m o 3R FPGA 77 5 SC BRI 4138 SPI Flash #8441 4E 48 4 1Nk 6-1 fir
TN, T3 WL Mxic 1 Winbond (172 554 2k

% 6-1 SPI Flash #1Ei5$

BiE 54
bulk_erase C7
page_program 02
read 03
fast_read 0B
write_enable 06
write_disable 04
!

Fo Sk FPGA SCHFIF Flash 248 & 2 & /0 —F 2 03 5 0B, W2 A E T
30MHz I8 FH 8 A Y e 2w T 30MHz IF, {8 P8 4, B s B 5 2
FASTRD_N & HIHifK, BEPSIZ A6 T 80MHz.
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HRFREAE R ITAG BLERNWY R, A A KB K5
FHE L5 S BSDL O3 T 2844 A TAE; % 8% 245 FPGA 4% F i 4h 56
Flash AT #FR A1 S #AE

NSRRI R
1. ¥ FPGA JFkiiEH:S| PC JF L H;

2. 77t Gowin mfE A4 OB B 2R 1F;

3. 1E Operation T 77 Ak /M6 Flash #:4E, I 540 <11 bscan

B, e 7-1 s
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{4 Programmer - Untitled* = | B8] X
File Edit View Design Tools Help
T = = — p— g, e m -
el asez] | O»
lEnal:lel Family 1 Device 1 Operation 1 File l Checksum l L
m GW2AR GW2AR-18  exFlash Erase Program in bscan  Di/software/Gowin/1.7.2beta/wark/ledwate... 0x779E ("
{ Y
W Device Configuration m
Dewice Operation
Aeocesz Made: External Flash Mode ']
Operation: exFlash Eraze, Frogram in bscan "J
exFlash Erase, Program
Erasze and prozram the extermal 5FexFlash Frogram
Make sure the config frequency ip exFlazh Eraze .
- exFlash Erasze Frozram in bscan
exFlash Program in bscan
Frogramming Options exFlash Erase in bscan
Programming File: T. Zbeta/workfledwater/impl/prr/ledwater. f= E]
< | . 3
External Flash Options
=
i . Device: Winbond #25Q64 -] &
Start Addr=s: 0x00000000
[ ok ][ Concel |
—
Output Error Warning | Info |

H R EAE HBEXT FPGA 4M# Flash #EATHAE, TN E Flash 5%
SRAM HHATRAEECE . 4 FHMEAIEgAESNE Flash B A2 580 FPGA
MODE {i % &, HZMET MSPI #4E R4 FEAMEB Flash (7732, L4

FERAT R iR B 1% o
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